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Chapter 1

Introduction

About this User’s Manual

This manual covers QuickFigure Works for both the MessagePad and the
Apple eMate. When the instructions for the application differ based on the
platform, explanations for both platforms are included. Simply follow the
procedures that apply to you.

Generally, the instructions differ where the eMate’s keyboard commands can
be used to replace pen tapping. Most of the keyboard commands that apply to
the eMate can be used with the optional keyboard for the MessagePad. See the
section “Using a keyboard” for an explanation of the keyboard commands.

Newton platform terms

The following is a list of some of the Newton platform terms that are important
to understand when using this manual.

• All machines based on Newton technology are referred to as Newton devices.

• The list that appears when you tap a button is a menu.

• The word “select” is used interchangeably with the word “tap.” When the manual
instructs you to select a menu item from a pop-up list, you can tap it with the
Newton pen. You can also select it by highlighting the item with the up/down
arrows and pressing Return on the keyboard.

• The word “select” is also used to refer to selecting a cell or range of cells for editing
and routing purposes. The context should make it clear when you should select a
cell versus a menu item.
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• When the manual instructs you to tap the diamond, you can tap the diamond  or
the word next to the diamond to get a list of choices. Diamonds always signify that
multiple options are available if the diamond is tapped.

• A slip is a window that allows the you to enter data or set options when it appears.

• Routing is setting up a document to be printed, faxed, e-mailed, or beamed.

What is QuickFigure Works?

QuickFigure Works is a full-featured spreadsheet application that allows you to
create and edit spreadsheets from within the Newton Works application.
A spreadsheet is a document you can use to store, analyze, manipulate, and
calculate data such as numbers, formulas, or text. See the section below for an
overview of spreadsheets.

QuickFigure Works also includes a charting utility called QChart that lets you
present your spreadsheet data visually. Some versions of QuickFigure Works
may also include QuickFigure Exchange, an application that enables you to
directly exchange spreadsheet data with Microsoft’s Excel®.

An overview of spreadsheets

Some users of QuickFigure Works will find the program easy to use because of
their familiarity with spreadsheets. However, you do not have to be a spread-
sheet expert to understand and use QuickFigure Works. QuickFigure Works is
great for storing, calculating, managing, and communicating personal informa-
tion as well as business and academic data. Examples of possible uses include
balancing a checkbook, keeping track of work hours, creating invoices, or
recording and calculating the results from a science lab. QuickFigure Works
will carry out all arithmetic functions, so there is no need to worry about math
errors! All you have to do is enter the numbers and then tell QuickFigure
Works how you want them to be calculated.

The following is a description of the basic functions of a spreadsheet.
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A spreadsheet consists of cells that can contain labels or values. Labels are text
entries and values are numbers and formulas.

A formula is a sequence of values, cell addresses, functions, or operators that
produces a new value from existing values. Formulas always begin with an
equals (=) sign. See Chapter 4 for more information on formulas.

A function is a pre-written formula. See Chapter 4 for more information on
functions.

Operators are used to specify the operation (e.g., addition, subtraction,
multiplication, or division) that will be performed on the values in the formula.
See Chapter 4 for a table of operators that can be used with QuickFigure
Works.

A cell’s address corresponds to its column and the row location. For instance,
the address for the cell in the first column of the second row is A2.

To perform calculations, you can enter a formula into a cell that refers to the
contents of another cell or cells. To reference a cell, use its cell address. For
example, you can tell QuickFigure Works to add A1, A2, A3, and A4 and put
the sum in A5 by typing =sum(A1:A4) in cell A5.

Complex spreadsheets can compare many different scenarios that are all
dependent on a cell that contains a value such as an interest rate. Changing the
value of the interest rate will affect all the cells that are dependent on it.

For example, suppose you deposit $500 for twelve months into a savings
account with an annual interest rate of 6%. The following spreadsheet calcu-
lates the monthly balance on the account and the interest earned every month.
Cell A1 contains the monthly interest rate of 0.5%. Cells B1 through B12
calculate the monthly balance on the savings account by adding $500 plus the
interest earned to the previous month’s balance. Cell B2 contains the following
formula: =B1+500+(B1*$A1). Cells C1 through C12 calculate the amount of
interest earned every month. The formula in cell C2 is: =B2*$A1. Finally, cell
C14 totals the interest earned that year. Its formula is: =Sum(C1:C12).
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The above is a simple example, but QuickFigure Works can do much more. As
you begin using the program for basic tasks like the one described above, you
will become more familiar with the way a spreadsheet works and soon will
carry out complex operations with ease! If you would like to become more
familiar with spreadsheets, we suggest reading a book on spreadsheets or a
user’s manual for a desktop spreadsheet application.
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QuickFigure Works and Newton Works

When both QuickFigure Works and Newton Works are installed on your
Newton device, you can create and edit spreadsheets from within the Newton
Works application. To use QuickFigure Works, start the Newton Works
application and tap New. Select the spreadsheet option from the menu.
QuickFigure Works will open a new spreadsheet for editing.

You can manage spreadsheets just like other Newton Works documents. Just
start Newton Works and then press or tap the Overview button to see a list of
Newton Works documents. They will include any spreadsheets you’ve created.
On the MessagePad, the Overview button is the round dot next to the two
arrows on the built-in tool bar. On the eMate, the Overview button is located on
the keyboard.

Tap to open the spreadsheet 
document

Check the box to select the Newton Works stationery 

Tap to create a new Newton 
Works stationery item, 
including a spreadsheet.

Tap to file the 
selected (checked) 
item.

Tap to route (print, fax, 
beam or E-mail) the 
selected (checked) item.

Tap to return the the last 
open Newton Works 
stationery item.

This is the icon for a 
spreadsheet stationery item.
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Use the Newton Works overview to switch between spreadsheets and other
stationery items you’ve created, including other spreadsheets. To open another
spreadsheet, tap on it in the overview. You can file or route (print, fax, beam or
E-mail) spreadsheets from the Newton Works overview just like other
stationery items. New spreadsheets are automatically saved to the unfiled
documents folder until you file them to another folder. For more instructions on
printing, faxing or beaming the stationery items in Newton Works, see the
Newton Works documentation.

Installing QuickFigure Works on your Newton device

If you have this manual, then QuickFigure Works came pre-installed with your
Newton device. QuickFigure Exchange may also be pre-installed, depending on
which Newton device you have. The packages appear in the extensions drawer
as the following:

QuickFigure Works QFNewtWorks:donv
QuickFigure Exchange qfexch3:donv

Note: Tapping these icons does nothing. To use QuickFigure Works, run
Newton Works. See the previous section for instructions.

If you deleted one of the packages but wish to reinstall it later, simply install
the appropriate package from the disk or CD to your Newton device with any
appropriate installation utility. For complete instructions on installing packages
to your Newton device, see your MessagePad or eMate User’s Manual.

Installing QuickFigure Exchange on your desktop
computer

If your Newton device came with QuickFigure Exchange, you will need to
install the QuickFigure Exchange application on your desktop or laptop
computer in order to exchange data with your Newton device. To install, insert
the Newton Works disk or CD into your desktop computer and open the
QuickFigure Exchange folder from within the QuickFigure Works folder.



QuickFigure 12

Double click on the installer icon to install Exchange to your computer. The
installer icon is called “qfxsetup.xla” on Windows machines and “QF Ex-
change Installer” on Macintoshes.

The application is a Microsoft Excel Add-In. You must have Microsoft Excel
5.0 or greater to run it. When you start the installer, it will automatically open
Excel.

Removing QuickFigure Works from your Newton device
If you wish to completely remove QuickFigure Works from your Newton
device, open the Extras Drawer and go to the extensions folder. Make the
“scrub” gesture over the QFNewtWorks icon. If QuickFigure Exchange is
installed, it can be removed in the same way. See the above section “Installing
QuickFigure Works”

Using a keyboard
QuickFigure Works supports many keyboard commands allowing keyboard
users to work with their spreadsheets without using the pen. In addition to
simple shortcuts for opening the New menu and performing Edit commands,
the keyboard can be used to activate some buttons or select a range of cells.

Return can be used when a button is defaulted to automatically activate it’s
function. For example, press Return when a close box in a slip is defaulted and
the slip will close. A button that is defaulted has an extra border across it's top
and bottom.

To select a range of cells with the keyboard, hold down the shift key while
pressing the right or down arrows on the keyboard. The selected area will have
a dark gray border.

QuickFigure Works has shortcuts for Edit commands, Find, Find Again, and
Print. To view the shortcuts, you can tap the Edit, Tools, or Routing buttons.
The shortcuts can also be displayed by pressing the Command button. This
brings up a window displaying the keyboard shortcuts available throughout the
Newton Works application, including QuickFigure Works.
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Chapter 2

Using QuickFigure Works

Creating a new spreadsheet

To create a new spreadsheet, tap New and select Spreadsheet from the menu
that appears. If using a keyboard, you can press Command-N to open the New
menu, use the up/down arrows to highlight your selection, then press Return to
select the highlighted option. A new spreadsheet will appear on the screen with
the title slip open. Enter a title and tap  or press Return to close the slip.

Renaming a spreadsheet

To rename a spreadsheet, tap  the title in the upper left-hand corner and the title
slip will open. Enter a title and tap  or press Return to close the slip.

Duplicating a spreadsheet

To duplicate an existing spreadsheet, open it and select Duplicate from the
Routing button menu. QuickFigure Works will create an identical spreadsheet.
The name of the duplicate spreadsheet will be the same except the word “copy”
will be at the end of the name.

A spreadsheet can also be duplicated in the Newton Works overview. Open the
overview, check the spreadsheet you wish to duplicate and select Duplicate
from the Routing button menu. The duplicate spreadsheet will appear in the
overview.
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Deleting a spreadsheet

To delete a spreadsheet, open it and select Delete from the Routing button
menu. If you use Clear to clear the data from all the cells in a spreadsheet, the
spreadsheet is not deleted—it will still appear in the overview. Use Delete to
completely get rid of a spreadsheet.

You can also delete a spreadsheet in the Newton Works overview. Open the
overview, check the spreadsheet you wish to delete and select Delete from the
Routing button menu.

Switching to another spreadsheet

To see a list of your spreadsheets, tap the overview button (the round dot next
to the up and down arrows on the Message Pad or the Overview button on the
keyboard). This will display a list of the Newton Works stationery items you’ve
created. To find a spreadsheet, simply tap the name of the desired spreadsheet
in the overview, and it will open. The list of stationery items may be scrolled
using the up and down arrows at the bottom of the screen, or the up and down
arrows on the keyboard.

Entering data

When a spreadsheet is opened, an active cell is displayed with a darkened
border. The active cell determines where data will appear when it is entered in
the input line. To make a cell active, tap it.

The keyboard can also be used to move the active cell. The keyboard com-
mands that can be used are as follows:

Tab Moves the active cell one cell to
the right
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Shift -Tab Moves the active cell one cell to the left
Return Moves the active cell one cell down
Shift-Return Moves the active cell one cell up
Keyboard arrows Moves the active cell one cell in the direction of the

arrow

When a cell is active, its address will appear at the front of the input line. Use
the input line to enter numbers, labels, or formulas. To enter the data from the
input line into the spreadsheet, tap the Enter button or press Return on the
keyboard. To delete what you have written before it is entered, tap the Cancel
button .  See the picture on the following page to locate the input line, and
Enter and Cancel buttons.

When data is entered into the input line, the caret  appears. Once the caret
appears in the input line, tapping another cell will automatically enter its
address at the caret. If you tap on several cells in succession, QuickFigure
Works will enter their addresses and insert pluses (+) between them. If you
drag your pen through a range of cells, QuickFigure Works will enter the
addresses within a Sum formula. See the picture on the following page to locate
the input line and caret.

For easy editing, tap the caret in the input line for a menu of math functions and
editing controls. The character selected will appear to the left of the caret.

Note: To remove the caret from the input line so that another cell can be made
active without entering its address, you must tap the Enter or Cancel buttons, or
press Return on the keyboard.

On the following page is a picture of the QuickFigure Works screen with some
of the data entry features and buttons you’ll use most often.
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Types of data

QuickFigure Works decides if data is a value, formula, or label based on the
first character in the input string. Values (i.e., 48 or 0.50) can be entered
without any preceding notation. Formulas are preceded with an equals sign (=).
Labels must start with a letter or must be preceded with a single quotation mark
(’). The single quotation mark is necessary if you want to enter a label such as
1996 Income. The following section summarizes the procedures for entering
data into cells.
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VALUES

  Whole Numbers Enter directly.

  Fractions Enter 3/4 as 0.75 not as .75.

  Currency Numbers can be entered in currency format by
preceding the number with the local currency sign
(i.e., entering $12 will display as $12.00). In the
U.K., the pound sign must be followed with a space.
Numbers can also be formatted using the Format
slip. See the section below on number formatting for
instructions.

  Percentage Percentages may be entered using the “%” sign after.
The result will be treated as a percentage. For
example, the number 0.20 can be input as 20%.
However, percentage notation cannot be used in a
formula.

FORMULAS Start formulas with an equal sign (=). Formulas
include arithmetic operators (+, -, /, *) and functions
such as sin and cos. For example, =A1+A2 will
return the sum of A1 and A2.

Formulas may include numbers, cell names,
functions, and user defined functions. Formulas are
not case sensitive; however, they are converted to
upper case after they are entered (i.e. you can enter
=a1*a2, but if you look at the formula later, it will
read =A1*A2).

  Scientific Notation If you want to enter a number in scientific notation,
the number must be entered as a formula. For
example, “1.0 E10” should be entered as =1.0E10.
Be careful not to put a space between the “E” and the
exponent (1.0E10 will work fine, while 1.0 E10 or
1.0E 10 will not work).

LABELS Precede labels starting with a number with a single
quote mark. Labels beginning with a letter can be
entered directly.
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Function Shortcuts

Tapping the function button  displays a menu of some of the function
names supported by QuickFigure Works. To insert a function from the list, tap
the desired function. It will appear in the input line at the cursor. The function
menu does not include all of the functions supported by QuickFigure Works.
QuickFigure Works comes with over 70 functions, described in Chapter 4 of
this manual.

To add or delete functions from the functions menu select “Edit...” from the
bottom of the list of functions on the Functions menu. To add a new function,
enter the function as you would like it to appear in the input area and tap
“Add.”

If you want to edit or delete a function which is already on the list, tap the
diamond  and you will see a list of the functions in the menu. To edit or
delete any of them, select that function from the list. You may delete it by
tapping “Delete.” If you’d like to replace it, you can make changes to the
function or replace it entirely and tap “Replace.” Functions on the function
menu are inserted into the input area exactly as shown in the Function menu.
When you have made changes, tap  to close the slip.

Note: If you end your function with a “)” QuickFigure Works will automati-
cally position the cursor just before the “)” when the function is inserted into
the input area.

Jumping to a cell

If you would like to select a cell that is not in view, you can jump to that cell
immediately without scrolling. Tap the cell address in front of the input line to
bring up a slip for entering the cell you wish to jump to. If a cell is already
selected, it will be the default. The target cell can be specified by tapping a cell
or by writing in a cell address (letter-by-letter recognition is automatically
enabled). After the slip is closed, the target cell appears as the upper left hand
cell on the screen. The “Home” button will move you to cell A1.
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Scrolling the spreadsheet

There are three methods that can be used to scroll through a spreadsheet:

• To quickly move through the spreadsheet, drag the handles on the built-in Newton
Works scrolling bars.

• If you are using the keyboard, press the arrow keys to move the active cell beyond
the edge of the screen view to scroll the spreadsheet in that direction one row or
column at a time.

• You can use the up and down arrows on the MessagePad’s built-in button bar or the
keyboard scroll up and down buttons on the eMate to scroll the spreadsheet up and
down.

Selecting cells and ranges of cells

To select a single cell, place your pen on it until the Newton device makes a
sound and a heavy mark appears. Drag the mark across the cell and lift the pen.
The selected cell will appear with a dark gray border.

To select a range of cells, drag the mark through all of the cells you wish to
select. Drag the mark diagonally to select a block of cells.

A range can also be selected by using the Selection tool in the Tool menu. This
is useful if the range desired is larger than one screen. To use the selection slip,
tap Selection from the Tools menu and enter the desired cell address. Tap
Select or press Return and the area will appear with a dark gray border.

Note: QuickFigure Works will not automatically scroll to your selection. If the
area is out of view and you want to see it, you must scroll or jump to it.

To deselect a cell or range, tap outside of the selected area.

Note: Cells cannot be selected if there is a caret in the input line. QuickFigure
Works will simply fill in and sum any of the cells you try to select. To
eliminate the caret, tap the input line’s Cancel or Enter buttons.
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Dragging data into or out of QuickFigure Works

Data can be dragged directly into a QuickFigure Works worksheet, from either
the Newton device’s clipboard or from another application. If the data being
dragged into QuickFigure Works is tab separated text, it will be entered using
the cell the text is dropped into as the upper left corner of the range.

Tip: You can drag outlines and checklists from the Notes application into
QuickFigure Works, the structure of the outline will be preserved.

Data can be dragged from QuickFigure Works to another application or
stationery document. Select the cells you wish to drag (see the section on
selection in this chapter) and then place the pen within the area and drag it to
the edge of the screen. Hold the pen at the edge of the screen until you hear the
squeak that signals that the selection has been copied to the clipboard. To drag
it onto another document, simply open the document and drag the selection
from the clipboard to the area you wish to place it. The top left cell of the
selection will be placed where you lift the pen, and the rest of the selection will
fill in down and to the right.

Cutting, copying, pasting, and clearing cells

To cut, copy, paste, or clear a cell or range of cells, first select the area you
wish to edit. Then choose the appropriate command from the Edit menu:

Cut Copies the data in the selected cell(s) to the
clipboard, and then clears the cells.

Copy Copies the data in the selected cell(s) to the
clipboard.

Copy Value Copies the value of the formulas in the selected
cell(s) to the clipboard. The formulas are not copied.

Paste Paste enters the entire contents of the clipboard into
the selected area.
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Clear Deletes any data or formulas from the selected
cell(s). Another way to delete the contents of a
cell(s) is to make the scrubbing gesture over the
cell(s) you wish to delete.

Copying formulas

When a formula is moved to a new location, all the cells without absolute
reference that make up the formula are offset by the same amount as the cell.
For example, if cell A1 has a formula of =A2 +A3, and it is moved to cell B2,
the formula will be changed to =B3+B4.

Absolute references

Placing a dollar sign ($) before a cell name in a formula marks the cell
reference as absolute. This means that if the formula is copied to another cell,
the reference remains the same. For example:

C1: =$A1 + A2

If this cell is copied, and pasted into cell D2, the formula would become:

D2: =$A1 + B3

Note: QuickFigure Works does not support making only the row or only the
column absolute—the entire reference is either absolute or relative.

Using Fill All, Fill Right, Fill Down, and Fill Series

Fill All, Fill Right, and Fill Down can be used to copy the contents of one cell
to another cell or range of cells. Fill Series can be used to copy data from a cell
and add the data to a range of cells in increasing increments.

To use the fill options, select the cell you wish to copy and then drag the pen to
select the cells you wish to fill. Tap to open the Edit menu and select the
appropriate Fill method. The contents of the upper and/or left-most cell will fill
into the cells in the selected range.
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Below is a table of the Fill methods and results:

Fill All Fill All takes data in the upper left cell of the
selected area and enters it into all of the cells in the
area.

Fill Right Fill Right takes the data in the left-most column and
enters it into all the cells of the selected range.

Fill Down Fill Down takes the data in the first row of the
selected range and enters it into all the cells in the
range.

Fill Series Fill Series takes the number or date in a cell and adds
to it in increasing increments determined by the user,
then fills the series into the selected range.

When the Fill Series option is selected from the Edit menu, a slip appears for
setting the increments by which the series will increase.

Tap the diamonds  to change the settings if necessary. When finished tap Fill
or press Return.

Inserting or deleting a column or row

To insert a column or row, select a range in a column or row adjacent to where
you want the new column or row inserted. Then tap the Edit button and select
Insert. QuickFigure Works inserts a column or row directly to the right of or
below a selected range. This function cannot be undone.
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To delete a column or row, select a range in the column or row you wish to
delete. Then tap the Edit button and select Delete. This function cannot be
undone.

Note: The Insert or Delete options will not appear in the Edit menu if only one
cell is selected.

Setting the column width for a single column

There are two ways to set the column width for one column.

• When a cell is active or a column is selected, this icon appears at the top of the
column and can be dragged to re-size it.

• Tap to make it active (or select a column) and then tap Options. Select Set Column
Width and enter a size in the slip that appears.

Setting the default column width for new spreadsheets

To change the default column width for new spreadsheets, tap “i”and select
Spreadsheet Prefs. Enter the desired column size in the slip that appears. This
will not change the column width for existing spreadsheets, only new ones.

Setting text styles

Text Styles allows you to control the justification, size, font, and style of
characters used in a spreadsheet. To change the format of a range of cells,
select the desired range and open the Text Styles slip from the Options menu.
When the slip is opened, the displayed settings will reflect the settings of the
top left cells of the selected range. After selecting the desired changes, close the
slip. The settings at the time the slip is closed will determine the format of all
the cells in the range.

QuickFigure Works’ default text format setting is Left justification, Simple
font, 10 point type. To change the spreadsheet’s default text format, open the
Text Styles slip and check the “Default text format” box.
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Setting the number format and decimal places

To set the format for a number in a cell or the numbers in a range of cells,
select the cell or cells you wish to format. Then select the Number Format
option from the Option button menu and tap the diamond for the list of
formatting choices. Select the format you want and close the slip.

To set the decimal places for a number in a cell or the numbers in range of
cells, first select the cell or cells you want to change. Then select the Number
Format option from the Option button menu and tap the diamond for the list of
decimal place choices. Select the number of places you want and close the slip.
You can set the number of decimal places shown for any number format.

The following is a description of the number format options:

General Displays numbers in the format 123456.78. No
thousands separator is used. This is the default
format.

%0.00 Displays numbers in percentage format. The default
number of decimal places for this format is two.
Percentage format can also be activated by entering a
percentage symbol after the  number.

0,000 Displays numbers with a thousands separator.

$0.00 Uses the currency symbol for the locale specified in
the Newton device’s Preferences. The default
number of decimal places for this format is two.

0.00e+00 Scientific notation. The default number of decimal
places for this format is two.

Note: QuickFigure Works does not allow you to set a default numeric format
for a spreadsheet. However, you may select a range of cells and set the numeric
formatting for that range prior to entering data.
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Protecting a cell

When a cell or range of cells is protected, the contents of the cell or cells can’t
be changed or erased. To protect a cell or cells, protection mode must first be
enabled. To enable the protection mode, tap the Options button and select
Enable Protection. Then select the cell or range of cells you wish to protect and
tap the Edit button. Select Protect and the selected area will be protected.
To unprotect the cell or cells, select the protected cell or range of cells and
select Unprotect from the Edit button menu. Disabling protection mode with
the options menu will also allow you to edit protected cells, but they will
remained designated protected cells until they are unprotected.

Label locking

This option allows you to lock the top row and left hand column of a spread-
sheet while you scroll through the rest of it. To enable label locking, tap the
Options button and select Enable Label Locking.

Disabling AutoRecalculation

This setting allows you to disable automatic recalculation for faster data entry.
To disable automatic recalculation, tap the Options button and select Disable
AutoRecalc.

Finding and changing data in cells

To find a number or a label, first select Find from the Tools menu. Enter the
number or label and tap Find.

To find and change a number or label, select Find from the Tools menu. Enter
the number or label and what you wish it to change to, then tap Find. To change
the found number or label, tap Change. If you want to change the number or
label and then find it’s next appearance in the spreadsheet, tap Change, Find.
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To change all occurrences of a found number or label, tap Change All.

Note: The active or selected cell determines where the starting point for the
Find search will be. QuickFigure Works begins searching from the upper left-
most selected or active cell. To search the entire spreadsheet, make cell A1 the
active cell before doing the Find. To search a specific area, select the area
before doing the Find.

Filing a spreadsheet

Spreadsheets can be filed in folders internally or on a memory card. To file the
current spreadsheet select the folder button at the button of the screen. Enter the
location and folder where you want to locate the spreadsheet. You can also
create and edit folders from this menu.

In the Newton Works overview mode, spreadsheets can be filed or deleted by
checking the box next to the spreadsheet and selecting the file icon for filing.
For more instruction on using the Newton Works overview, see the Newton
Works documentation.
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Chapter 3

Print, Fax, Beam, or E-mail

QuickFigure Works supports all the communications options available to
NewtonWorks, allowing you to print, fax, beam, or e-mail spreadsheets from
your Newton device. The fax and e-mail options require a modem, and the e-
mail option requires an e-mail application. For complete instructions on using
the communications options, see the User’s Manual that came with your
Newton device.

Printing a spreadsheet

QuickFigure Works enables you to print your spreadsheets on any printer your
Newton device will use. To print a spreadsheet, tap the Routing button , and
select Print Document. You will see the following dialog box:
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You can choose to print in portrait or landscape orientation. To select the
printing orientation, tap on the diamond next to Format. Then select your
printer by tapping the diamond next to Printer. If the correct printer is already
displayed, there is no need to reset the option. When the desired settings are
entered, tap Print. For more instructions on printing from Newton Works, see
the Newton Works documentation.

QuickFigure Works will only print pages that contain data. To see a preview of
the spreadsheet, tap Preview.

When you print a spreadsheet, the following options can be included:
• Row and column labels
• Grid lines
• Worksheet title
• Page numbers
• Date and time

To set the options for printing, select Print Options from the Option button’s
menu. Check the options you want included on the printed spreadsheet and
close the slip.

Note: Printing may use a lot of the Newton devices’s available memory. If you
encounter an “out of memory” message while printing or faxing, use Print
Later and close Newton Works.  You can then print from the Out Box.

Faxing a spreadsheet

When a modem is available, QuickFigure Works enables you to fax your
spreadsheets. To fax a spreadsheet, tap the Routing button , and select Fax.

Set the faxing options and choose a recipient, then tap Fax. To see a preview of
the fax, tap Preview. For more instructions on faxing a Newton Works
document, see the Newton Works documentation.

Tip: If you are having difficulties faxing (the other party is not receiving the
fax), try adding a cover sheet. The cover sheet sometimes gives QuickFigure
Works enough additional time during faxing to complete sending the first page.
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Beaming a spreadsheet

QuickFigure Works allows you to beam a spreadsheet between two Newton
devices (MessagePad or eMate) if both have QuickFigure Works installed.
Simply point the Newton devices at each other and select Beam from the
Routing button, or press the eMate's Send button. Sending a spreadsheet is
identical to beaming a Notepad item or a Names card. See the Newton Works
documentation for more instructions on beaming.

When you have received a spreadsheet, you must put it away from the In Box
to work with it. After doing so, you can access it by opening the Newton Works
overview. The spreadsheet will appear in the overview.

E-mailing a spreadsheet

If your Newton device is configured to send e-mail with EnRoute or any
transport that supports sending Newton objects, you may send a QuickFigure
Works spreadsheet to another QuickFigure Works user.

Receiving a spreadsheet by e-mail is similar to receiving a spreadsheet by
beam. After receiving the spreadsheet, tap the spreadsheet name in the In Box,
and then tap Put Away. The spreadsheet will appear in the Newton Works
overview.

If you try to send a spreadsheet without EnRoute or another transport that
supports sending Newton objects, only the text message will be sent. A
transport that supports sending Newton objects will usually have a “Text Only”
option. For more instructions on e-mailing Newton Works documents, see the
Newton Works documentation.
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Chapter 4

Function Reference

Math operators and evaluation order
QuickFigure supports the following math operators, in order of precedence:

* Multiply
/ Divide
div Integer Division
mod Remainder
+ Addition
- Subtraction

Math statements are evaluated from left to right.
QuickFigure also supports the following logical comparisons:

< Less than
<= Less than or equal to
> Greater than
>= Greater than or equal to
= Equal
<> Not equal
not Logical not
and logical and
or logical or

Integer math functions
Max(a, b) Returns the maximum value of integers a and b.

Min(a, b) Returns the minimum value of the two integers a and
b.

Ceiling(x) Returns the smallest integer not less than the
specified real number. (Rounds up the real number to
an integer.)
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Floor(x) Returns the largest integer not greater than the
specified real number. (Rounds down the real
number to an integer.)

Real(x) Converts the specified integer to a real number.

Random (low, high) Returns a random integer in the range between the
two integers low and high. The range is inclusive of
the numbers low and high. For example:

Random(0,100) will return a number between “0”
and “100”.

SetRandomSeed (seedNumber) Seeds the random number generator with the
specified number. Without reseeding, the “Random”
function will generate the same series of random
numbers every time. The time function “ticks” can
be added in the following manner to create nearly
random numbers: SetRandomSeed(Ticks())

Floating point math functions

Abs(x) Absolute value of x.

Acos(x) Arc cosine of angle x.

Acosh(x) Arc-hyperbolic-cosine of angle x.

Asin(x) Arc sine of angle x.

Asinh(x) Arc-hyperbolic-sine of angle x.

Atan(x) Arc tangent of angle x.

Atan2(x,y) Arc tangent of x/y with result being between

-π and π.

Atanh (x) Arc-hyperbolic-tangent of angle x.

CopySign(x,y) Value with the magnitude of x and sign of y.

Cos(x) Cosine of angle x.

Cosh(x) Hyperbolic cosine of angle x.

Fmod(x,y) Floating-point modulus of x and y.
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Erf(x) Error function of x.

Erfc(x) Complementary error function of x.

Exp(x) Value e (2.718282) raised to the xth power.

Fabs(x) Floating point absolute value of x.

FDim(x,y) Positive difference between x and y.

FMax(x,y) Maximum of x and y.

FMin(x,y) Minimum of x and y.

Gamma(x) Gamma function of x.

Hypot(x,y) Square root of the sum of the squares of x and y.

IsFinite(x) Returns “true” if x is finite and “nil” if x is infinite.

LGamma Base-e logarithm of the absolute value of the gamma

of x, for x>0>Logb(x).

Ln(x) Natural logarithm (base e) of x.

Logb(x) Binary exponent of x as a signed integral value.

Input is treated as normalized.

Log(x) Logarithm (base 10) of x

Pi Returns the value of pi (3.1415927...)

Pow(x,y) Value of x to the yth power.

Remainder (x,y) Remainder when x is divided by y.

Round(x) Rounds x to the nearest integer.

Sin(x) Sine of angle x.

Signum(x) Returns -1 if x<0, 0 if x=0, and 1 if x>0.

Sinh(x) Hyperbolic sine of angle x.

Sqrt(x) Square root of x.

Tan(x) Tangent of angle x.

Tanh(x) Hyperbolic tangent of angle x.

Trunc(x) Returns the integer portion of x.

Notes: 1. Angles must be expressed in radians.
2. Unless otherwise noted, the parameters for floating point functions can be
  integers or real numbers.
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Financial functions
For financial functions the following variable names are used:

rate The interest rate is the rate per period (e.g., 6% per
year would be specified as a monthly rate of 0.005).

periods The number of periods (e.g., 6 months)

nper same as periods

pmt periodic payment amount

pv present value

fv future value

Following is a list of financial functions available:

Annuity(rate, periods): Calculates the present value of an annuity at a given
interest rate over the specified number of periods.

Compound(rate, periods): Calculates compounded interest over the specified
number of periods.

FV(rate, nper, pmt, pv) Calculates the future value of an investment based
on a series of equal payments. Rate is the periodic
interest rate, nper is the number of periods, pmt is
the periodic payment amount, and pv is the future
value. Payment at the end of period is assumed
(ordinary annuity).

NPV(range, rate) Calculates the net present value of an investment
based on a series of periodic cash flows (range) and
the discount rate (rate).

PMT(rate, nper, pv, fv) Calculates the periodic payment required for a given
interest rate (rate), number of periods (nper), present
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value (pv), and future value (fv). Payment at the end
of period is assumed (ordinary annuity). Use the
following formula to calculate the payment required
for an annuity due (payment at beginning of period):
PMT(rate, nper, pv, fv)/(1 + rate)

PV(rate, nper, pmt, fv) Calculates the present value of an investment based
on a series of equal payments (pmt), discounted at
the periodic interest rate (rate) over a specified
number of periods (nper), given a future value (fv).
Payment at the end of period is assumed (ordinary
annuity).

SLN(cost, salvage, life) Calculates the straight-line depreciation of an asset
for a single period.

SYD(cost, salvage, life, period) Calculates the sum-of-the-years’-digits depreciation
for specified period. The period must be stated in the
same units as the life.

The following is an example of using a financial function to calculate data:

Suppose you are going to start a savings account and you’d like to calculate
how much you can save and accumulate with interest if you deposit money on a
regular basis over a given period. You to plan to deposit $500.00 each month
for the next 10 years into your savings account. The interest rate on the account
is 0.5% monthly (6% annually). To calculate the value of the account at the end
of 10 years, enter the FV function with the following data in a cell formatted
for currency:

=FV(0.005,120,-500,0)

Tap enter  or press Return. The following result will appear in the cell:

= $81,939.67
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Note: Positive cash flows are represented with positive numbers and negative
cash flows with negative numbers. In the above example, the payment amount
was -500 because it represented an outflow of cash.

Statistical functions
AVERAGE(FirstCell:LastCell) Calculates the average of a range of values.

NUM(FirstCell:LastCell) Determines how many cells within range have a non-
zero numeric value.

SDV(FirstCell:LastCell) Calculates the sample standard deviation of a range
of values.

SUM(FirstCell:LastCell) Calculates the total of the values of all the cells
within the specified range.

VAR(FirstCell:LastCell) Calculates sample variance of a range of values.

MaxRange(FirstCell:LastCell) Returns the largest numeric value in the specified
range.

MinRange(FirstCell:LastCell) Returns the smallest numeric value in the specified
range.

Time and date functions
DateAdd(date, days) Adds days to date and returns the result (a date).

DaysDiff(date1, date2) Returns the number of days between date1 and
date2.

 HoursDiff(time1, time2) Returns the number of hours between time1 and
time2.

 MinutesDiff(time1, time2) Returns the number of minutes between time1 and
time2.

 today() Returns today’s date in the format
(“1/19/95”).
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 now() Returns the present time (“8:03 PM”).

In addition, the following NewtonScript functions may be used:

 time() Returns the time in number of minutes since
midnight, January 1, 1904.

 ShortDate(time) Returns a date (“Tue 5/3”) from an integer, based on
the number of minutes since midnight, January 1,
1904.

 HourMinute(time) Returns the time from an integer, similar to
ShortDate.

 StringToDate(dateString) Returns the equivalent time in minutes since
midnight, January 1, 1904.

 StringToTime(timeString) Functions like StringToDate, except it uses time.

Date literals must be enclosed in quotation marks, if they are to be used in a
formula. For example, =DateAdd(B1,“8/24/96”) will add B1 and 8/24/96. If
dates are entered directly into a cell, no quotation marks are necessary. Thus,
you can enter 9/24/96 into a cell B2, and then use =DateAdd(B1,B2).

 All date functions accept dates in the following formats:

 Jan 2, 1992
 12:05 1/2/92
 1/2/92
 12:05mon, 1/2
 1/2

If the year is omitted, it is assumed to be the current year.
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Chapter 5

Working with Graphs and Charts

Introduction

QChart is the graphing and charting extension for QuickFigure Works. It lets
you display and print data from QuickFigure Works using x-y plots or line, bar,
or pie charts.

Charts may be printed or faxed, and are automatically saved with the associated
worksheet. Below is an example of a chart that appears when QChart is
selected from the Tools menu.
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Creating Graphs and Charts

To create a graph or chart, select some cells in QuickFigure Works and select
QChart from the Tools menu. QChart will open, and a chart of your data will
appear. Each time you create a chart, it is saved with the worksheet. Any
number of charts can be created from the data in a single worksheet.

To see a list of the charts associated with a spreadsheet, select QChart from the
tools menu when one or no cells are selected.

The title of the worksheet is used as the default title of the chart.

To change the chart type or other chart formatting, tap the Setup button. This
will bring up the Chart Setup slip.

The size of the chart displayed on the screen can be controlled by tapping the
Show button.  Full size, large size, medium size and small size are available.
Full size represents a full 8 1/2 by 11 inch page when printed.

Using the Chart Setup slip

The Chart Setup slip lets you control the appearance of a chart. You can modify
the chart type, title, axis legends, scaling, and whether the data series are
organized by rows or columns.
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Chart Title controls the large text which appears at the top of the chart.

X-Axis Legend controls the small text which appears below the X-Axis border.

Y-Axis Legend controls the small text which appears to the left of the Y-Axis
border. Please note that the Y-Axis legend can display no more than 15
characters.

Chart Type allows you to choose from Bar, Line, Pie, or X-Y Plot.

Data Series determines whether a separate data series will be created for each
row or column of cells.

Series Legends controls the positioning of the series legends box.

Vertical Scale controls how much of the Y-Axis is visible (this option only
appears for line, bar, and X-Y Plot chart types).

Horizontal Scale controls how much of the X-Axis is visible (this option only
appears for the X-Y Plot chart type).

Note: An x-y plot will appear only if two columns of data are selected. If more
than two are selected, the x-y plot option will not appear in the Setup slip's
chart type options.

Working with saved charts

Each chart you create is automatically saved with the associated worksheet.
If you tap the overview button (located between the global scrolling arrows)
while QChart is visible, the “Select Chart” slip will appear, and will list the
charts associated with the current worksheet.
If you open QChart with one or fewer cells selected, the Select Chart slip will
appear automatically.

Note: If there are no saved charts, the Open and Delete buttons will not be
visible.
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Tapping on a chart name in the list of saved charts will display the type of chart
and the range of cells it displays beneath the list of charts. To open the
currently selected chart, tap on the Open button. To delete the currently
selected chart, tap on the Delete button.

When a chart is opened, the chart will update to display the data currently in the
QuickFigure spreadsheet.

Using graphs and charts with other Newton applications

You can integrate graphs and charts with other applications by copying the
chart to the Newton device’s clipboard. To do this, either use the pen to drag
the chart to the edge of the display, tap Copy, or type command-C on the
keyboard. We suggest reducing a chart to large size or smaller when copying to
another application, as the full size chart may not fit in the application's page.

When the chart is on the clipboard, it may be dragged into other applications
which support graphics (such as the Newton Works Word Processor).

Note: If the chart is dragged into another application, and the resulting
document is transferred to a Newton device which does not support grayscale
images, errors may result.

Printing and faxing charts

Charts may be printed or faxed, just like any other Newton Works document.
To print or fax a chart, simply tap the Routing button and select either Print
Chart or Fax. Note: Each chart is formatted to fit a complete 8.5 x 11 page.
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Chapter 6

QuickFigure Exchange

Introduction

QuickFigure Exchange is a system for transferring worksheet information
between QuickFigure and Microsoft Excel. It consists of a QuickFigure Tool,
and a Microsoft Excel add-in.

You can transfer entire worksheets, or selections from within a worksheet.
Most worksheet data is preserved, including numeric and text formatting,
column widths, formulas, and values.

Transfers can be made using either serial or Macintosh AppleTalk connections.

Note: QuickFigure Exchange requires Microsoft Excel 5.0 version or later.

Installing QuickFigure Exchange on your desktop

QuickFigure Exchange is a tool that is added to Microsoft Excel's library of
add-in tools. The Excel tools library is in a folder called "Macro Library" on a
Macintosh, or "Library" on a Windows PC. In order to successfully install the
QuickFigure Exchange tool, the version of Excel that you are using must
include the tools Library folder. If the tools Library folder has been deleted, or
was excluded from the Excel installation, the installation will fail.  If so, Excel
must be deleted and re-installed on your machine in order for the tool to be
used.

To install QuickFigure Exchange, insert the QuickFigure disk and launch the
QF Exchange Installer application (install.xla for Windows). This application
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will open Microsoft Excel and install QuickFigure Exchange. If you get an
error message, it is likely that Excel has lost the path to it's own Tools Library.
See the troubleshooting instructions in this chapter for solutions.

A note to users using Excel over a network: QuickFigure Exchange has not
been tested with networked copies of Excel. However, the QuickFigure
Exchange tool may work if installed on the server where the Excel Library/
Macro Library is stored. Again, this has not been tested, and may not work
properly.

Configuring QuickFigure Exchange for Macintosh

To configure QuickFigure Exchange for Macintosh, open Microsoft Excel and
select Settings from the QuickFigure menu. You can then choose the connec-
tion type and port used (for serial connections).

Configuring QuickFigure Exchange for Windows

To configure QuickFigure Exchange for Windows, open Microsoft Excel and
select Settings from the QuickFigure menu. You can then select the appropriate
comm. port.

Transferring data from QuickFigure Works to the Desktop

To transfer a worksheet to the desktop, use the following steps:

1. Connect a cable from your Newton device to the desktop computer.
2. Open the worksheet you wish to transfer in QuickFigure.
3. Open Microsoft Excel.
4. Select QuickFigure Exchange from the QuickFigure Tools menu.
5. Tap Send in the QuickFigure Exchange application.
6. Choose Receive Worksheet from the QuickFigure menu in Excel.
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Transferring a spreadsheet from the Desktop to
QuickFigure Works

1. Connect a cable from your Newton device to the desktop computer.
2. Open the worksheet you wish to transfer in Excel.
3. Open Newton Works, and create a new worksheet.
4. Tap Receive in the QuickFigure Exchange application.
5. Select QuickFigure Exchange from the QuickFigure’s Tools menu.
6. Choose Send Worksheet or Send Selection from the QuickFigure menu in
Excel.

If the Newton "times-out" (gives the message "Unable to Connect...") before
the desktop is done "Scanning for data", close the alert slip and tap Receive
again when the desktop says "Waiting for Newton Connection".

Note: If you do not create a new worksheet in QuickFigure to receive data into,
any cells transferred will overwrite cells in the existing worksheet. However,
cells in the existing worksheet which are not overwritten will not be modified.

Troubleshooting

First, make sure that you are using Version 5 or later of Microsoft Excel.

Here are solutions to common problems:

1. No QuickFigure menu appears in the Excel menu bar.

Make sure that QuickFigure Exchange has been installed using the QuickFigure
Exchange Installer application. If it has been installed properly, select Add-Ins
from Excel’s Tools menu, and make sure that the QuickFigure Exchange Add-
In is checked.

2. The Newton device fails to connect to the desktop.

a. If you have Newton Connection utilites running, close it to free the port.
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b. Check that the connection types are the same on both the Newton device and
the desktop computer (serial, or AppleTalk).

c. AppleTalk Connections: Make sure that the correct computer is displayed in
the Connect To slip in QuickFigure Exchange. If this is not correct, tap it and
choose Other Computer from the pop-up. The chooser dialog should appear.

Serial Connections: Check that QuickFigure Exchange on the desktop is
configured to use the appropriate serial port, and that the serial port is available.

d.  If you are sending data from the Newton to the desktop, make sure that you
tap Send on the Newton before you click Receive Worksheet on the desktop.

If you are sending from the desktop to Newton, the Newton may be "timing
out" before the desktop has completed it's data conversion process.  Watch the
status bar in Excel for the progress of the data conversion. As it works, it gives
the message "Scanning for data" with a counter showing it's progress. Wait
until it is almost finished, or until it says "Waiting for Newton Connection"
before tapping Receive on the Newton.

3. The desktop reports that a problem has occurred and does not connect.

Open the Excel Tools, then Options, and select the Module General tab. Ensure
that the Break on all Exceptions is turned off.

4. You get an error message (like "File Not Found ") when you try to install
QuickFigure Exchange.

First, verify that your copy of Excel has a Macro Library (Macintosh) or
Library (Windows) folder. If it doesn't, it will need to be installed before you
can use the tool. The surest way to install it properly is to delete the entire
Excel folder (make sure to empty the trash or recycle bin after you put it there),
and then install it again.  If the Library was present, proceed to the next step.

Second, check to make sure the QFX Installer (Install.xla for Windows) is
together with the folder called "Files" in the QF Exchange folder. If the files
appear to be in their proper place, proceed with the instructions for either
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Macintosh or Windows. If not, move the file and run the Installer again.

Macintosh-

Close Excel and follow these steps:

1. Drag the Excel folder to your Macintosh Desktop.
2. Open the Excel folder, then open the Macro Library folder.
3. Double-click on the file "Update Add-in links". This should open Excel.
4. Drag down the File menu in Excel and choose "Open".
5. Find the QFX Installer and open it.
6. If you don't have a worksheet open, do so. If the QuickFigure item does not
show up in the menu bar at the top of Excel, drag down the "Tools" menu and
select "Add-Ins".  Find QuickFigure Exchange in the list and check it, then
click OK. When QuickFigure shows up in your Excel menu, you're ready to use
Exchange.

The Excel folder can be moved back off of the Desktop, but the folder level
where you move it may interfere with Excel's use of it's Macro Library. If the
tool again throws an error, close Excel and try moving it's folder to a different
(probably higher) level. Then double-click on the "Update Add-in links" file in
the Macro Library. You can experiment with moving it and updating the link
until the transfer is successful.

Windows-

1. Open Excel.
2. Drag down the File menu in Excel and choose "Open".
3. Find the install.xla file and open it.
4.  If you don't have a worksheet open, do so. If the QuickFigure item does not
show up in the menu bar at the top of Excel, drag down the "Tools" menu and
select "Add-Ins".  Find QuickFigure Exchange in the list and check it, then
click OK. When QuickFigure shows up in your Excel menu, you're ready to use
Exchange.
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Chapter 7

Advanced QuickFigure Operations

Using “If” statements
QuickFigure allows you to use conditional statements within cells. The primary
conditional statement is the “If” statement, which has the following syntax:

IF logical_test THEN action <ELSE action>

“logical_test” means any conditional expression which evaluates to a true or
false. Examples of expressions include A1=3, A1>2, and so on. “Action”
generally refers to any math expression or number, the value of which will
appear in the cell with the “If” statement. Examples of actions include 34, and
A1+2. The “ELSE” portion of the statement is optional.

Examples of “If” statements:

A1: =IF A3 > 5 THEN 3 ELSE 7

When this statement is entered, if the value of A3 is greater than 5 then the
value of A1 will be 3. Otherwise, A1 will have a value of 7.

A1: =IF A2 = 3 THEN A5*2

When this statement is entered, if the value of A2 is equal to 3, then the value
of A1 will be A5 multiplied by two.

A1: =IF A3 < 10 THEN A3/3 ELSE A7*2

When this statement is entered, if the value of A3 is less than 10, then the value
of A1 will be A3 divided by 3. If the value of A3 is 10 or greater, then the
value of A1 will be A7 multiplied by 2.

For compatability with desktop spreadsheets, you may wish to use the “eIf”
function. This function is identical to the “If” function in Microsoft Excel, and
has the following parameters: test, action, and else action.



QuickFigure 47

Using vLookup and hLookup functions
QuickFigure Pro supports vLookup and hLookup functions. These functions
allow you to search a specified range for a matching value or string, and then
look down or across a specified number of rows or columns to return a value.
The syntax for these functions is as follows:

vLookup vLookup(lookup_value,range,offset)

hLookup hLookup(lookup_value,range,offset)

Lookup_value is the value or string which is the object of the search. Range is
the range (e.g., A1:B3) in which the search is done, and where the lookup value
is found. It is important to ensure that the range includes all the values in the
lookup table.

Offset is how many rows or columns to move to find the returned value. For
vLookup, the offset represents the number of columns over that the function
looks, starting with the column in which the lookup_value is found (an offset of
1 would return the lookup_value). For hLookup, the offset represents the
number of rows down that the function looks, starting with the row in which
the lookup_value is found (an offset of 1 would return the lookup_value).

Note: If the cell reference returned by the lookup function is outside of the
specified range, the value of the cell reference will be returned, but this value
will not be updated if the cell subsequently changes.

User defined functions
You may define your own custom functions for use in QuickFigure spread-
sheets. To do this, you must have a blank cell to store the function. The format
of custom functions is:

FUNC(Argument) expression

Argument refers to any information you wish to pass to the function. It could
be a list, separated by commas.
The expression uses information from argument(s) to generate the solution. For
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example:

A1: =FUNC(X) X*2

creates a function which multiplies whatever is passed to it by 2. To call this
function from another cell, you would use:

B1: = :A1(2)

The value of B1 will now be 4.

Functions may also use lists of arguments. For example,

A1: =FUNC(A,B,C) (A+B)/C

When this function is called,

B1: = :A1(3,4,5)

QuickFigure Works adds 3 and 4 and divides the result by 5. The final result is

1.4 and is displayed in cell B1.

Note: When you store a function in a cell (such as cell A1 above), there is no
value displayed for that cell. This can be good from a presentation point of
view, but it requires that you keep careful track of where your custom functions
are located.
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Chapter 8

Troubleshooting

Memory
Problems you may encounter with QuickFigure Works may be memory related.
The Newton device divides memory into many different categories. There is
user memory, which is what you see if you select Memory from Prefs, and
where the 1 or 2 megabytes from your RAM card is allocated (if you have one).
This kind of memory is analogous to a disk drive on a Macintosh or a PC.

The kind of memory which causes problems, however, is “frames heap
memory.” This memory is more analogous to RAM on a PC or Macintosh.
Frames heap memory is not increased by a RAM card. Running too many
applications at once will reduce the available frames heap memory, and can
cause the following symptoms.

Symptoms

Memory problems are indicated by either an error message (“Newton does not
have enough memory. . .”, followed by Cancel and Restart buttons), or by
strange behavior on the part of QuickFigure—the grid disappears, or
QuickFigure seems to run very slow, for example.

Solutions

The best solution is to reset the Newton device. This will free up a great deal of
frames heap memory and things should be fine again. Using a heap clean-up
utility should have the same result. Freezing other third party applications with
freezing utilities should also generally relieve memory problems.

If you are still having problems, especially with the spreadsheet you were using
when you ran out of memory, then it is possible that some of the data for that
spreadsheet may have been corrupted. To repair this, first make sure that you
have recently reset your Newton device. Then, select all the cells you are using,
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copy them (using Copy from the Edit button), create a new spreadsheet and
paste the cells into it. You may then delete the old worksheet. This should
resolve any problems.

Common causes for VALUE! and how to eliminate them
QuickFigure Works will return the statement "VALUE!" when an invalid
formula is entered. If you keep running into the VALUE! message in a cell,
there are several likely causes:

1. If you are using a fractional number, be sure to precede it with a 0. For example,
.75 should be written as 0.75.

2.  If you are using the financial functions, each of the arguments must have a value
of some sort.

Technical Support
If you have a question and are unable find the answer in this manual, or if you
see a Newton error message (a sound, and a notification box saying, “A
problem has occurred”, followed by a number, such as 48807), please let us
know. Support is available at the following e-mail addresses and numbers:

Internet: support@pelicanware.com
Phone: (503) 221-1148
Fax: (503) 224-0582

In addition, you can visit our Website for technical information, frequently-
asked questions, and information on updates. The address is:
http://www.pelicanware.com.

Our U.S. Mail address is:

PelicanWare, Inc.
550 S.W. Park Avenue, Suite 270
Portland, OR 97205

We hope you enjoy using QuickFigure Works!
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SOFTWARE LICENSE

PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THE SOFTWARE. BY USING THE
SOFTWARE YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO
NOT AGREE TO THE TERMS OF THIS LICENSE, PROMPTLY RETURN THE PRODUCT TO THE
PLACE WHERE YOU OBTAINED IT AND YOUR MONEY WILL BE REFUNDED.

1. License. The application, demonstration, system and other software accompanying this License, whether on
disk, in read only memory, or on any other media (the “Software”), the related documentation and fonts are
licensed to you by PelicanWare, Inc. You own the media on which the Software and fonts are recorded but
PelicanWare, Inc. and/or PelicanWare, Inc.’s Licensor(s), if any, retain title to the Software, related documentation
and fonts. This License allows you to use the Software and fonts on a single Newton Product (which, for purposes
of this License, shall mean a product bearing Apple Computer Inc.'s Newton logo), and make one copy of the
Software and fonts in machine-readable form for backup purposes only. You must reproduce on such copy the
PelicanWare, Inc. copyright notice and any other proprietary legends that were on the original copy of the Software
and fonts. You may also transfer all your license rights in the Software and fonts, the backup copy of the Software
and fonts, the related documentation and a copy of this License to another party, provided the other party reads and
agrees to accept the terms and conditions of this License.

2. Restrictions. The Software contains copyrighted material, trade secrets and other proprietary material and in
order to protect them you may not decompile, reverse engineer, disassemble or otherwise reduce the Software to a
human-perceivable form. You may not modify, network, rent, lease, loan, distribute, or create derivative works
based upon the Software in whole or in part. You may not electronically transmit the Software from one device to
another or over a network.

3. Termination. This License is effective until terminated. You may terminate this License at any time by
destroying the Software and related documentation and fonts. This License will terminate immediately without
notice from PelicanWare, Inc. if you fail to comply with any provision of this License. Upon termination, you must
destroy the Software, related documentation, and fonts.

4. Export Law Assurances. You agree and certify that neither the Software nor any other technical data received
from PelicanWare, Inc., nor the direct product thereof, will be exported outside the United States except as
authorized and permitted by the laws and regulations of the United States. If the Software has been rightfully
obtained by you outside of the United States, you agree that the direct product thereof, except as permitted by the
laws and regulations of the United States and the laws and regulations of the jurisdiction in which you obtained the
Software.

5. Government End Users. If you are acquiring the Software and fonts on behalf of any unit or agency of the
United States Government, the following provisions apply. The Government agrees:

(i) If the Software and fonts are supplied to the Department of Defense (DoD), the Software and fonts
are classified as “Commercial Computer Software” and the Government is acquiring only “restricted rights” in the
Software, it’s documentation and fonts as that term is defined in Clause 252.227-7013(c)(1) of the DFARS; and

(ii) If the Software and fonts are supplied to any unit or agency of the United States Government other
than DoD, the Government’s rights in the Software, its documentation and fonts will be defined in Clause 52.227-
19(c)(2) of the FAR, or in the case of NASA, in clause 18-52.227-86(d) of the NASA supplement to the FAR.

6. Disclaimer of Warranty on Software. You expressly acknowledge and agree that use of the Software and fonts
is at your sole risk. The Software, related documentation, and fonts are provided “AS IS” and without warranty of
any kind and PelicanWare, Inc. and PelicanWare, Inc.’s Licensor(s), if any, (for the purpose of provisions 6 and 7



QuickFigure 52

shall be collectively referred to as “PelicanWare, Inc.”) EXPRESSLY DISCLAIM ALL WARRANTIES,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. PELICAN SOFTWARE, INC. DOES
NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR
REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR
ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE AND THE FONTS WILL BE CORRECTED.
FURTHERMORE, PELICAN SOFTWARE, INC. DOES NOT WARRANT OR MAKE ANY REPRESENTA-
TIONS REGARDING THE USE OF THE RESULTS OF THE USE OF THE SOFTWARE AND FONTS OR
RELATED DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR
OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY PELICAN SOFTWARE,
INC. OR AN AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY
INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU
(AND NOT PELICAN SOFTWARE, INC. OR A PELICAN SOFTWARE, INC. AUTHORIZED REPRESENTA-
TIVE) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE
ABOVE EXCLUSION MAY NOT APPLY TO YOU.

7. Limitation of Liability. UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE SHALL PELICAN
SOFTWARE, INC. BE LIABLE FOR ANY INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES
THAT RESULT FROM THE USE OR INABILITY TO USE THE SOFTWARE OR RELATED DOCUMENTA-
TION, EVEN IF PELICAN SOFTWARE, INC. OR AN AUTHORIZED REPRESENTATIVE HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE
LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO
THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. In no event shall PelicanWare,
Inc.’s total liability to you for all damages, losses, and causes of action (whether in contract, tort (including
negligence) or otherwise) exceed the amount paid by you for the Software and fonts.

8. Controlling Law and Severability. This License shall be governed and construed in accordance with the laws
of the United States and the State of Oregon, as applied to agreements entered into and to be performed entirely
within Oregon between Oregon residents. If for any reason a court of competent jurisdiction finds any provision of
the License, or portion thereof, to be unenforceable, that provision of the License shall be enforced to the
maximum extent permissible so as to effect the intent of the parties, and the remainder of this License shall
continue in full force and effect.

9. Complete Agreement. This License constitutes the entire agreement between the parties with respect to the use
of the Software, related documentation and fonts, and supersedes all prior or contemporaneous understandings or
agreements, written or oral, regarding such subject matter. No amendment to or modification of this License will
be binding unless in writing and signed by a duly authorized representative of PelicanWare, Inc.



QuickFigure 53

Index

A

Absolute references  21
Active cell

defined  14
entering data into the  14

Addition  30
Annuity  33
AppleTalk connection  41, 44

B

Beaming  29

C

Cancel button  15
Caret  15
Cell

jumping to a  18
Cells

active  14
clearing  20
copying  20
cutting  20
pasting  20

Charts  37
copying to other applications  40
creating  38
opening  39
printing or faxing  40-41

Clear  20-21
Clipboard  20
Columns

deleting  22
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inserting  22
setting the default width of  23
setting width of  23

Compound rate  33
Conditional statements  44
Copy  20-21
Cosine  31
Cut  20-21

D

Time and date functions  35-37
Dates

formats  36
in formulas  36

Decimal places  24-25
Deleting a column  23
Deleting a row  23
Deselecting cells  19
Divide  30

E

E-mailing  29-30
eMate  6
Enter button  15
Entering data  14
Excel  41,42,43
Exchanging data with a desktop computer  41-46

F

Faxing  28-29
Filing  26-27
Fill All  21-22
Fill Down  21-22
Fill Right  21-22
Fill Series  21-22
Financial functions  33-34

Annuity  33
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Compound rate  33
Periods  33
Rate  33

Find  30
Find and change  30
Floating point math functions  31-32

Cosine  31
Sine  32
Square root  32

Fonts  23-24
Format

number  24-25
text  23-24

Formulas  16
copying  21
defined  8, 17

Function button  18
Function Shortcuts  18
Functions  30-37

defined  8
Financial functions  33
Floating point math functions  31
Integer math functions  30
user defined  47

G

Graphs  37
copying to other applications  40
creating  38
opening  39
printing or faxing  40-41

H

hLookup  47

I

If statements  46
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Input line  15
Inserting a column  22
Inserting a row  22
Installing QuickFigure Exchange  11-12
Integer division  30
Integer math functions  30-31

Floor  31
Maximum  30
Minimum  30
Random  31
Real  31

J

Jumping to a cell  18-19
Justification of text  23

K

Keyboard
shortcuts  12-13
using with QF works  12-13

L

Label locking  25
Labels  16

defined  8, 17

M

Math operators  30
Addition  30
Divide  30
Integer division  30
Multiply  30
Remainders 30
Subtraction  30

Memory  49-50
Microsoft Excel  41, 42, 43-45
Multiply  30
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N

Number format  24-25

O

Operators. See also Math operators
defined  8

P

Paste  20-21
Percentage format  21
Periods  33
Printing  27-28

options  28
Protecting cells  25

Q

QuickFigure Exchange  41-44

R

Rate  30
Recalculation  25
Remainder  30
Routing  27

defined  7
Rows

deleting  27
inserting  27

S

Scientific notation  25
Scrolling  19
Selecting

cells or ranges  19
defined  6-7

Serial connection  41, 43
Sine  32
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Size  23-24
Slips  5
Spreadsheets

copying  13
creating new  10-11, 21
defined  7-13
deleting  14
dragging data to or from  20
modifying existing  14
naming  13
opening existing  10-11
switching between  11, 14

Square root  32
Statistical functions  35

Average  35
Sum  35

Styles, text  23-24
Subtraction  30

T

Technical support  50
Text styles  23-24
Time and date functions  35-37
Transferring data  41-44
Troubleshooting  49-51

V

VALUE!  50
Values  16

defined  8
types  17

vLookup  47


